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Al S xS L, ANk 20 B R SR 2 s 1Al
FHL R L E e A (A% .
PSSR T R SR RN B o TP LR, R <AV > S S il 1 ok i [ 47 v, off i [ 7 4
N ke AR T P
BT REANTE AL HECR AT A .
T BRI e dem it (4% .

WERTCIER] <Pifl> Zhagse aifBRmE sl WIRTIY <HUR> . SR HH <iol> Zhig.

UEDhREAAE BEdEl B AT

S REv

A A i
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R

B

MagicColor

K H HH Samsung Electronics flf & (1% A0 el i it e H8oAR, FEJCH0m 5 AT H T 535 I [ 28

WoRE R .

o <X> - M MagicColor Jhfig.

o <JH7R> - BEPEHAE ] MagicColor A3 6 55 J5 AR B 34T LU
o <HEA> - FIHRALELHR R 6 SR TE A IR S D T I I

o <HRE> - BEEE Pk ORI A R

2. (R)

SRR NS TN T REEARCIN
% <MagicColor> ¥ <5e4x> Fialol < fg> B, HIRAR A

zx (G)

TR A N YT S
1 <MagicColor> ¥ '# N <5¢4e> Bl < fg> B, B pAmTH .

(B

BT AN N L T 1
i <MagicColor> ¥4 <sg4r> Bk < fE> B, AT,

il

T PR N B BH (R

o <A>-BPEEEAERRE RE.

o <IEH> - K bR B A bR UE A .

o <BE> - BEREE MR,

o <M ANBE> - RIS, W FERE AR
WA IB (lR,  TTF3) Y <P lgo> B

1 <MagicColor> # 5 h <554> BaEl < fe> B, MR AR H .

LRGN P ES

T T T T ] P R S SRS O AU

4 <MagicColor> % & by <5 4> #E <3 fg> BN, AT H
o <> - KM EIHAUR DRk,

o <HA>- LM ACEIRE N

o <G> — LIS RIRE

o <IRIE> - LIRS BORE .

o <FEME> - A LAERHE (O o E

Y
Wi}

W R, AR T O AR S T R R
o <HEFL> - <A 2> - <HEEF(3>

<4 <MagicBright> ¥ & N <sh AT > B, <> hEA i .

[ R/ANFIALE
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R B

P VAN VI R 27 R T N e e WSO A
UEDhREAAE BEdEl B AT

EIISKIAY A FAZ B s XA B e I
UEDRENUAE AUl AT W A

] o <EIED> - P SRR A 5 I L T R
o <HIF> - BRI R, ARG T I L I.

o ASCRRRHERLUR A R IE 5
o ADPPRWEN RS PR, ik <miii R > Bt E N <H3h> bt <TEhE>,

6 U AR AN TR AL
SR B &R OSD MK A7 &
B VA &I OSD )3 FA

[ REMEE

K VLEA
XA A5 ) e A R R B B S O ) R B
S
S HRLIZ W TNl iEFE OSD [1EW] % .
o <Ke>-<IP>
5 P OSD IHiF .

« ¥iE, English

JITETE S AN T A b (¥ OSD. L BEE AL PC (¥ HABT)fE .

SN TR W EshVER, OSD ¥4 HEhil 2k,
Rl OSD B iy I 25 £ 1 1)

o <5 Fb>-<10 #> - <20 Fb> - <200 #b>

A A i



FER

SH LB

(=) BIRAE PC LA KPR > HE
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4 ZEEB

4-1 PColP

R (OSD)

LA RIS TIT R HoREET PCoIP 233, B Bor 453280 (OSD) A#h GUI (i Portal) . OSD figfit 7 — i g 4 322 i 1 £1) - 4L
BTN B R oR R .

T 3 3 I T IS ] D IR AR T 10 SETWES AT AR SR 1 B0 i A A BE Web FUTT TR AL Ny ShfE . R B T L
<Options> FALRI AT [ E A 1. FEH 4 Portal JEI, 5 EH N HE D3 w500
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HEREH T

BrAk Portal CUHCE b 525 BN A 2 Ek B S FOER:, 15 WPKEAEH 2 I oo B i

T <Connect> #4 EJ7 HIbRIN, Al i B Web Fi i 80 He & 15

EERR T AT T 100 W 2% B bR /s SO HRAS o L AL 0045 A5 19 2% B bR Sy U R 1] 2-1 s (IR

2-1: OSD &%

Options

——
TERADICI

WER MG E bR L X7, RN LA EAE R SOE A ERIIGL (BT IESE S 30 Portal) « PIZEAR A I, R BoRarer
X7 Mg EER (il 2-2) .

K 2-2: MZART CHTIED

2-3 IR T L T IS P 19 45 PR A o

K 2-3: Mg (ATED

Connect ¥4

251 E, 48 Connect 4441 J %) PColP 5 RDP 431 454 PColP M4, OSD Al GUI Ko “&fids:” W
Jho JERET G, OSD AHE GUI B 2k I th 2 % KGR A o
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K] 2-4: OSD HE#zmi  CIEAEERD

e
TERADICI

Cancel

Contacting 192.168.1.100, please wait...

OSD <Options> 38

IE$E <Options> SRk HHBL— ML F 41K . OSD <Options> 3 A5 :
e <Configuration>

« <Diagnostics>

e <Information>

e <User Settings>

¢ <Password>

PR ML IURE R — MR R H

4 2-5: OSD <Options> i

Configuration
Diagnostics
Informition
User Sattings
Fasswiord

T
TERADICI

Connect

TR



<Configuration> &
FH Bl <Configuration> & 1197 ) i BIE I, X2k E w2 X T Portal (19 1T4F 77 0L S3E H 81677 20,
<Configuration> % [+ &I+ 17 :
e <Network>

e <lLabel>

¢ <Connection Management>

e <Discovery>

e <Session>

¢ <RDP>

e <lLanguage>

e <OSD>

e <Reset>

¢ <VMware View>

FIRIR P <OK>, <Cancel>. <Apply> %4, A& B3] Tl 3 642 41 1252 sl B0 2N B IR E s S 5.

HB5r PCoIP BEAAE T i, JoTs S0 R Al A FE W LUy i) OSD 4.l PColP 4 R4l & ) H 2 sk T T
1 OSD [ # i R4

<Network> &I
FFHE G AE T <Network> $EI- 13 Portal M2 %,

=

i GO 6 T TR Network 250

¥l 2-6: <Network> fit &

Mitwirk. |Label | Gonnection Managemant | Discovery [Session [RDP [Lenguege [0S [Resat [viware view

Change the network: settings for the davica

Enabla DHCF: [
1P Address: 1921168, 46 L1121
Submet Mask: 255 285, 255, 0
Sateway! 192 168 .46 L1

Primery DNS Server: 102, 168.1 | &2
Secondary DNS Server: 182, 163.1 L 50
Dicriin Marma:

FADM:  |pcolp-portal- 101588301 384

SRR R

¢ <Enable DHCP>
WA A <Enable DHCP>, #4152 DHCP JIR45 43 KM IP ik, 7 PIHERL . W9OC 1P Ml Hl DNS 5. A4
M, MFHETB) R EIX S

e <|P Address>
<IP address> ‘7 BUZ IR IP Mk, W45 DHCP, WIATHSIL B, WG H] DHCP, WL BoA al gk . 1t
FBOB SN AR 1P Mk, W AN T IERR 1P Mk,  OSD RO B R AT B R

¢ <Subnet Mask>
<Subnet Mask> F-BUEAR A 7 MY . W25 DHCP, MG 7B % B DHCP, Wt 7 BN i g
U B AU AR T RS, W N T G T RS, OSD K an s B AT I I

¢ <Gateway>
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<Gateway> 7 BUEAR & 1M C IP Hulk. W45 DHCP, WA TS 7B, W5 H DHCP, W7 B il 4k .
e <Primary DNS Server>

<Primary DNS Server > 7B 4534 14745 DNS 1P #ulih. 3 BOGREIN . A DHCP, 7 BEAS T gt
e <Secondary DNS Server>

<Secondary DNS Server> 7BUEIR R4 XY DNS IP Hitht. 7 BOYEIEIN., 4055 ] DHCP, It 7 BOR i 44k
¢ <Domain Name>

<Domain Name> J&F5 1Al (19584, il “domain.local” . ML BEIENIN, 7B EHLEK Portal JiT s f4k .
+ <FQDN>

<FQDN> J&45 =Lk Portal f15¢4s & #84 . 2RIAH peoip-host-MAC 1k pcoip-portal-MAC, JLH MAC #§ EHLEk Portal

1) MAC Hitik o S AR BRIA B FQDN, K sl LRI 4, 14 pcoip-host-MAC.domain.local.

A FQDN Difig, 404 £85di& Ml & ¥ DHCP J£15 81 1) DNS 45 2.
e <Ethernet Mode>

<Ethernet Mode> 7Bt il it & Portal [ LA R . 3K Mk 10 4,45 «

e <Auto>

e <10 Mbps Full-Duplex>

e <100 Mbps Full-Duplex>

W HAB M 28 Vs Clnsg bl tBcE 4 BL <10 Mbps Full-Duplex> &% <100 Mbps Full-Duplex> 47, WA HE 5 W
U2 <Ethernet Mode> B2 4 <Auto>, JFf HAU A ] <10 Mbps Full-Duplex> 5k <100 Mbps Full-Duplex>.

<Label> &I &
FH G ATE T <Label> IR o4 AL Portal %8 B & SUE &

A I U L5 T FTIR  Portal Label 244

2-7: <Label> it &

[ Mtror | Lavet | connection Management | Discovery | session [RoP [ Languags | 050 [Reset [ vMwars view

Configura the davice identification

POaP Davica tome: | EREEEIEECIER |
PColF Davica Description: |

Generc Teg: | |

e <PColP Device Name>
B[l <PColP Device Name> J EHLuk Portal 455 N2 AFR. 2RiAN pcoip-host-MAC 5§ pcoip-portal-MAC,
Hrf MAC #& 3 #1EL Portal 1) MAC Hidil:.
e <PColP Device Description>
FH i E i <PColP Device Description> 24 FEA/LE Portal 35 15 B a5 2245 5, 9 a5 AR A7 .
itk PColP [ {1 TG#:Af Ff <PColP Device Description>, Jf H 4545 18 5 4 0] 48 H 7 Bk .

e <Generic Tag>
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L L <Generic Tag> & ALk Portal 5 — AR 25 (5 B .
iEk PColP [ TA$ T <Generic Tag>, J H A48 H G A4 o) 7 B

<Connection Management> ¥~
<Connection Management> £ 1 1] i J sl AR FE R B, b T Hioe R B A (1) 1P Mk

e EBL%EH: T,  <Connection Managerment> #4545 1T 5 3440 5, v PRI AL B e 45 o BhAh, @ sias ]
SE AV A BRI (3 M Ay, I 8% HE. <Connection management> AL AL T KA, 2 ARG L.

A5 T 94 4% R I A, n) i Connection Management 224 .

4 2-8: <Connection Management> fic /4

Nitwork |Laed | Connection Manegement | Discovary [Session [ROP [Langusgs [0S0 [Reset [umsans visw ]

Configure the devica for a managed connection

Enable Connection Management: 1

Idantify Connection Managar by:  * IP Address FQOM
Connaction Manager IP Address:

Enabie Event Log Nolfication:

Enatda Diagnostic Log: [0

oK || Concel Apply

¢ <Enable Connection Management>
4 %5 <Enable Connection Management> 310, T A0 $2 8 B a4 4% ] 6k g 047 1ic v RN 8 3L
¢ <ldentify Connection Manager By>

i@l <Identify Connection Manager By> iE#64%, 45 #0101 v LUk $EE T <IP address> i/ 582 G i44 (FQDN) kil
S, WRCARERE R, WL BN AR G

K 2-1 P TP PR FOREN TR E S S R T CR0 1P ik sl DNS %K, OSD Kif/s i Bl 5 AT
Hik.

R 2-1:. EEETHEELTE

WS BIRFE
<IP address> RS A 1P Ml
<FQDN> R AE DNS 4K

¢ <Enable Event Log Notification>

<Enable Event Log Notification> =7 B¢ il 451l PColP F-HLF1 Portal 545 2 75 1) 45 IR 45 28 i ek H R 4%
« <Enable Diagnostic Log>

<Enable Diagnostic Log> - Bt 34 il & 75 5 445 FAH S i B 5 N PColP LA Portal 3 & 13 4F H &

<Discovery> &k
<Discovery> it B Wi o ) D RE (T H - B PColP F 4t H 1) Portal

T DA B ) E . Discovery S8
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2-9: <Discovery> it &

Hatwork, | Label | Gonnection Management | Discovery | Session |RDP |Language | 05D |Reset | vidware view |

Automaticaly discover other PColP devices.

* <Enable Discovery>

W T <Enable Discovery> i35, #4411 H] SLP Discovery A RN B4, 16T 2858 T I M4 b 1 fr
B XKD I RGN E R 4E T TAE.

L] SLP Discovery, "tk th @ lo B0 2 fifkik, DILHER{# /1] DNS-SRV Discovery & ILHLH .

¢ <Enable Host Discovery>
<Enable Host Discovery> 3jfig i fii Portal & 3L A{E PColP £:if 7 i L.
JA I, Portal W] 4% & B KR R R i 2 ik 10 S H EHL. <Enable Host Discovery> g /e EH LI

<Session> &£
FFHL A Il IT <Session> KEI R HCE W R W IR R SR K.

T3 P T B I AT L Session .

] 2-10: <Session> it &

[sework | Labed | connection Management | Discovery | #esson |RDP [ Languaga [0S0 [Reset [wwars view

Configure the connection to & peer davica

Sesshon Typa:  FColF =

KMy Piar by:  * 1P Addreds FQDM
Poer IP Address: 192 . 1621 . 100
Peor MAC Address: 00 - 00 - 00 - 00 - 00 - 00
Enabla Auto-Reconnact:

L e

e <Session Type>
PR T <Session Type> i PColP £:ifel RDP £:iffil & Portal.

¢ <lIdentify Peer By>
LR TR <Identify Peer By> 2E#% gkt 1L IP Al MAC Hidibid J i ik 58 4 A A% 38 44 (FQDN) AR 1% 45 15 4
R 2-2 I TEPRIL AT P OB AT X SR S A W N T ERT 1P HhEER DNS 48K, OSD B4 s 2 i

LI AL: 4-1



HATHIE.

2 2-2: MNERRHTITE

XTI BE TR #IE
%45 IPIMAC S 1P Huhk PColP & Portal RDP %/ i
X4 MAC Hihit: PColP
%4 FQDN %% FQDN PColP X Portal RDP % )" Jji

* <Enable Auto-Reconnect>
<Enable Auto-Reconnect> &I LT Portal 764 1% 722K 5 H B B HNE R R L —UoE B 4L,

<RDP>
FH R T <RDP> KR G AR S MY (KRDP>) BB M5

30 3ok Y A BT S A TRV RDP S8

K 2-11: <RDP> Jit'#

[gtwart [ Labet | Gonnection Menagement | Discovary [ Session | 0P [Language [ 05D [Reset [vidware view

Changa the ROP-specilic corfiguration

Resoktion:  |Native Resolution] |
Enaspm:
Terminal Server Port:
Audio Mode:  [Piay on clent ||
Enatle Walpaper: [
Enable Thames: [

<Resolution>
<Resolution> 7 BUE it <RDP> i f5 /0 M. nl EfI(E AT
¢ <Native Resolution>
e <B800x600>

e <1024x768>

e <1280x768>

e <1280x1024>

e <1440x900>

e <1600x1200>

e <1680x1050>

e <1920x1080>

e <1920x1200>

<Bit Depth>
<Bit Depth> /& fif <RDP> Zxili RO IRE . AT BEIEAT :

e <8bpp> (N4 %)
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* <16 bpp>
e <24 bpp>

<Terminal Server Port>

<Terminal Server Port> 7B ] 35 <RDP> %% F i 42 21 (1) 115

<Audio Mode>

Iiid <Audio Mode> 7Bt r 4 <RDP> 2> 1FH 0 B & MHE MU B . W] RE B IA -

e <None>
e <Play on client>

¢ <Play on host>

<Enable Wallpaper>
iWiT <Enable Wallpaper> B ] 75 <RDP> 23 ii i b F #E4G

<Enable Themes>
jlil <Enable Themes> F-EX A 7E <RDP> 2xiF v i FH 5 i 1=
<Language> &Ik

R <Language> F-BUICE OSD #5 .

JE I Y DA B ST R AT G B Language S 40

2-12: <Language> it &

[Matwork [Latat [Connestion Menagsment [ Discovary [Sessicn [RoP | Lanouase | 050 [raset [viwers view |
Select a language for the user interface
Language:  English |7
Keyboard Layout:  |USA 150-8850-1 Izl
[ ok | Cencet |  Appwy
<Language>

Wil <Language> 7 BYAIACE OSD iF & Al 7 4t H & A .

<Keyboard Layout>
PG i T <Keyboard Layout> 7Bt CCBEA A R

<OSD> &Ik
FEL AT <OSD> i< & MR HESE . (OSD>) 4.

3ot Y BRSBTS A T OSD 24K

TR
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2-13: <OSD> [ii%

Metweork, | Latel | Connection | piscovery [ession [ROP [Languags | 050 |Reset | viwars view

Change the settings of the On Screan Display

Sereen-Saver Taxt:
Screen-Saver Timeout: Seconds (0= disabled)

ok | cencel |  acoi

<Screen-Saver Message>

BRI G Al <Screen-Saver Message> 7Bt OSD AR FLF I SCA . 1% UA R AT 240 T4,
i ORGP R P BT S s S e ER 47 S 7 ) 17 PP PO €0 1

<Screen-Saver Timeout>

FH BTl T <Screen-Saver Timeout> - BEALE bt F (R P FE 7 I I 18] o BB I Iy 8] AT AR g B b AT IC B f5 KA 9999 7
BEE A O FPUIAS ) b e R 4P 27

<Reset> ¥ &
I G IE ) <Reset> I T 1 INAE TP AEAE I T A AT I E S

L3 P P T TR U XSS

2-14. <Reset>

| Lot | Gonnection Management |0 y [ 5ession [RDR [ |05 | Resst |wware view |

Resat o configuration and permissions settings stored on tha devica

Rese Poametrs

<Reset Parameters>

JE il <Reset Parameters> [1] Reset #4111 T fi i B ITA AL E A A 8 KT BRI IEFULIZ4INS, OSD K4/~ i # b ik
PLB 1B R A o
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<VMware View> I &
it <VMware View> <Al & VMware View 382 Ik 45 25 (I S E o

AT ) T B S TG VMware View S4 .

Kl 2-15: <VMware View> fit &

[ Mstwors: [Lebed | Gonnection Managemant | Discavary [ Session [ROP [Lengusge [05D [Reset | vMware view |

VMware View

Configure the View Connection Server (RDP enly) seitings for the device

Ty ieriidobis Wik Fsburds, e “Eridbb Conriclion Mansgerent” chackbox under “Cormbction Mardgeman™
tab must be unchacked

Enabla Vidwara View: [

Iduntify Connection Server by: = 1P Addrgss FODM
Connection Server (P Address:
Port: (Dafauk is 500
5L Usa secure confaction (S5L)
Ayto connect: Abways connect to this sarver at startup

<Enable VMware View>

Jii Hl <Enable VMware View> ZEI, A1K; Portal fit & b 5 VMware View 15 Ik 45 g fic &5 H .

ZHH VMware View Jifig, WA ZiHE 2% <Connection Management> £ -+ 1) <Enable Connection Management>
<ldentify Connection Server by>

FIL T <ldentify Connection Server by> e 2l 1P Hidibid & 58 254 84 (FQDN) Sk lERAE Mlds .
REAH VMware View, TS BEAN D B AN 4% o

<Port>

EH R IE T <Port> Z8dE e H 5 VMware View 42 [ 5 4 W45 130 1.

<SSL>

EHLR L <SSL> 43R E <SSL> 1) VMware View &4 /R4 A 70 1

<Auto connect>
B IHE T <Auto connect> Z33E & B BN Portal #H4 A3 5 VMware View 35 155 24 HE 742

<Diagnostics> & H

paren

=

F G ATk <Diagnostics> Vi il 47 5% Portal i2 Wi & LI . <Diagnostics> i LI H ¥ =17 :

<Event Log>
<Session Statistics>
<PColP Processor>

<Ping >

FANIETR A Close $&8 TG A1 .
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<Event Log> &I+~
I AT <Event Log> &I M Portal 2 & JHE BRI H G & .

JAL e 4 U ST 42 7T 5 ) <Event Log>  (RZEERIHAD

¥ 2-16: <Event Log>

Diagnostics

Evant Log | Session Statistics | PGol Processer |Fing |
WView avent log messages
0d, 01134152, 906> Teradic! corporation (c)2007
e, 01134252, 906> Normal
e, 01:34:52. 906> Firmware version: 0.18
0, 01134152, 906> Firmware Build I0: wi0z
el iz, m Firmware nullld d-lu Nm 22 2007 23ridiod
0d, 01134152, 906> Oull00, revision: 0.0
0, 0L 34 5F, 455 mwrﬂ llur :Mt'l(a) PROALOOO PL mEtwork connection (Microsoft's
Packet Scheduler)
O, 01:34:53. 531> Boot-up ©
e, 01134195, 531> un|qu-| :dmuﬂar 00-15-87-SC-BF-64 -1 fert-2
0d,01134:53. 531> HDA 15 enabled
e, 01134233, 546> POST. aﬂurm PHY TEST PASSED
i, 0113453, St POST. D Ao Left PASSED
0, 01134153, 546> POST: self-Test PASSED
o, 0134295, 985> Merwork Tink rave: 100 wbiess, duplex: FuLL
0, 01334353, 953> Requesting OHCP Tea
0, 01135102, 455> EXherner [LAN) Adlﬂ'“l'.?ﬁ! 168, 0,142, 00-15-07-5C-BF-647
0, 0113502, 7A5% ONS based discover
O, 01135102, TE5> RNU}' T Connect J(nr'ml

<View event log message>
<View event log messages> ‘7~ B Al on ity A I8 MBS B EEW R 1% 7By A~ ] F .

¢ <Refresh>
Iﬁ% <Refresh> r%TEJ%ﬁJLT H/J%:/ﬁ: El lu/ﬁ/§~ °
¢ <Clear>

Ii% <C|ear> #%ﬂj{ﬁ K/%.LKTE@F)?%%'T# E] Au\/ﬁ ;%\o

<Session Statistics> &
EHLBE R <Session Statistics> £k A% Portal ") L Xif3) PColP &l (IA15E PColP Ziitfi .

. <3t o LA T L A ] P <Session Statistics> (R ZEEEEARD .

2-17: <Session Statistics>

Diagnostics

Evant Log | Session Statistics |PGolP Processor [Ping|

Vigw statistics from the lzst session

PColP Packets Sent:
PColP Packels Received:
PColP Packets Lost:
Bytes Sent:

Bytes Racaived:

Round Trip Latency:
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<PColP Packets Statistics>
e <PColP Packets Sent>
<PColP Packets Sent> 7Bt af#it it FikiGigh4sif - Portal & i%45 4L PColP 3ii B4k,
e <PColP Packets Received>
<PColP Packets Received> =B it & _bikiGah2xifith Portal A LB PColP i (. 5 5.
e <PColP Packets Lost>
<PColP Packets Lost> ‘7Bt it 5 LG s 21 vh 2 k1) PColP i (0. 5 4K
<Bytes Statistics>
* <Bytes Sent>
<Bytes Sent> “FE A5 EIG ST AR IR T L
e <Bytes Received>
<Bytes Received> Bt I % )2 il B i) B -
<Round Trip Latency>
<Round Trip Latency> FB i[5 1Ei% PColP R4: (fi M\ Portal | ML 12 Portal ) 1]IRF )T R4 2% G 15 1) (R S0, 2Ar
FHFE (+1- 1 ms).
<PColP Processor> &I
S AlE T <PColP Processors %1575 % Portal PColP 4bF 4L [ F— R B 2 B A IE 5 1247 I 1]

JE 3 Y LA B LTI 1) £ B <PColP Processor> 1F 3347 IR ]

2-18: <PColP Processor>

|Everl Log ISesshn Stalistics | PColP Processor |Bing

Wignw the time since boot

Uptime 0 Days 1 Hours 58 Minutes 36 Seconds

<Ping> &k

EH R <Ping> 3R ping AU, AEFEIER 1P ML rERRNZ A . Xk T E R L A T
% k.

B % 1 i ST B A T A S <Ping> I AR LA 3L
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2-19: <Ping >

Event Log | Session Statistics | PGolP Processor | Fing

Draterming if a host is reachabla across the network

Ping &
e <Destination>

% ping 1 IP Hihksk FQDN
e <Interval>

ping it e 1] (1 s 1] 1] B
e <Packet Size>

ping Fd A i K/
HEa
e <Sent>

KAL) ping et L Ht
¢ <Received>

Yo ¥ ping Kt 1K) Ko

<Information> &

M I <Information> & U7 )6 7 % 21 Version ZEI< .
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i P A T A

& 2-20: <Version>

Informnation
Vergion

“Wieny the hardware and firmwarne version informiation

MAC Agdress: 00-15-87-9C-83-64
Uniqus Identifier: 00-15-87-9C-83-64-clart-2
Serial Nurnbar:
Firmvwane Part Number: PW010003
Herdware Version:

Firmware Version: 0.20
Firmveara Build ID: 120
Firniweara Build Date; Mar 20 2008 18:40:40

PColP Procassor Revision: 0.0

Eoctlaadar Version: 0.0
Bootlcader Buld ID:
Eocticader Buld Date:

VPD g &
AR (VPD) 2 fiih T #2410 % Portal s LA ME— U E.
e <MAC Address>
Portal [fJ#— <MAC address>
e <Unique ldentifier>
Portal bR i4F
e <Serial Number>
Portal {7415
e <Firmware Part Number>
PColP [EfFi %A
e <Hardware Version>

Portal {1} A5

EEREEPSY
<Firmware Information> S WK 2 247 PColP [ {F ¥ 74015 B -
e <Firmware Version>
M PCoIP [ 1 A
e <Firmware Build ID>
4 PColP [ & 1T AR
e <Firmware Build Date>

T PColP [H44 1 57 H 1

<PColP Processor Revision>

<PColP Processor Revision> 1511 7B a[ i 15 PColP A% & T4 . 0.0 F7x TERALX00 AbBESS BT A; 1.0 o
TERA1X00 AbFEZEFME1T it B.

RBnEEFER
J BN A B B T PCoIP 3 i AP I v aies B
e <Bootloader Version>
21 PColP JA SN FE I RA
e <Bootloader Build ID>
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i PColP JH B IR BT ARG
¢ <Bootloader Build Date>
i PColP JH B IN4AE 7 i v H 9

<User Settings> & H
FH P ARl <User Settings> % 1 Ui 1) % IR, DL SRR A AL 325 DL PColP 8 i .
User Settings S8 LI -< A7 :

e <Mouse>
e <Keyboard>

« <Image>

<Mouse> &I
JH 7 Al <Mouse> LT B 2 OSD 1 RDP 21 i BUbris £ 38 o 4

34T PColP &}, W% OSD RARFRFHE B E AN BARTRET B, BRAFIEAE A A B A T HLIK B 4% 2
e GEZP (PColP LHURIFHHRM) THEZEED .

o B L ERO I SO B S A S <Mouse> BB IR AT RV RS L

2-21: <Mouse>

User Settings

Mouse |I-<eyboard |Image |

Adjust the mouse cursor speed

Slow
Mouse speed;

¢ <Mouse Speed>
i) <Mouse Speed> B it & Portal BUbRRERHE .

it PColP ENUK MBI E <Mouse Speed>, A AfiH PColP EHLKAFMITEAIFEE, EZi (PColP ENLKA:
P RED .

<Keyboard> #IH
F o AliEak <Keyboard> 23+ 5 2 OSD #ll RDP £ i (A ik i .
o T PCoIP 4 ifith], T OSD #ft i B A sg MR 1 E, BRARIEFEAE A A E VLIRS #s iR Gl
N (PColP THUKMH Fam) THEEZEED .
o 1 ERA MM DU FE S AT S <Keyboard> 5 R A Y RIS L.
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2-22: <Keyboard>

User Sefttings
Mouse | Keyboard |Image|

Adjust the keyboard character repeat settings

Long
Keyboard Repeat Delay:

Slow
Keyboard Repeat Rate:

Repeat Settings Test Box: |

¢ <Keyboard Repeat Delay >

FH Pl <Keyboard Repeat Delay> 7Bt it & Portal 441 SR IER .
e <Keyboard Repeat Rate>

F Pafilid <Keyboard Repeat Rate> 7 Bt it & Portal 4 4 H 460 %
¢ <Repeat Settings Test Box >

AT <Repeat Settings Test Box> 7 Bl e £ (0 AL 4

<Image>
el <image> #i PColP R4 KGR EE .

S 4 A AT A, R R 2

2-23: <Image>

User Settings

Mouse ]Keyb-oard |3I“-’la§0

Adjust the image settings (the maximum valees may be limited by your
administrator)

Perception-Frae

U
Minimum Image Quality: —.
L]

e <Minimum Image Quality>
AP <Minimal Image Quality> T He bl i 19 26 415 0 52 B3 I 1 1 o e R 48 o K6l 9 TR 745 e PRI 28 1 1 fig
T BRI G s o — LA A T AR DI 2 T T it T 2682 v ) PS5 i
TEM 285 T2 BREREE T, Wrk i PRg nl <Reduced>, T AT HIIAA A my MU 2 Wi PRSI <Perception-Free>, T[4
AR T
TEM 2885 TEANZ BRI, T518 <Minimum Image Quality> Wi % %, PColP R4k F1F <perception-free> K ikt .
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<Password> & K
FH G E T <Password> T L HT A A EL D . R S Ok Web ST AIARL <OSD> GUI.

SEHr Portal (5 IN A2 BT, BUAWIRER T30S, W REILAER] Portal,

o T GO BRSO AT A

o 4> PColP B EERINELL FASHI B S Oy, I Hatb <Password> & HIA R ], Wil PColP B B & 5 Hlix 451
# [V Ry ThBE .

2

i 2-24: <Change Password>

Change Password

Old Password: "

Mew Password: |

Confirm New Password: |

e <Old Password>
<Old Password> -Bt HUH 5 i i B T TTHC IS A ] HEAT T 0
¢ <New Password>
<New Password> 7Bt £ il Web FLiiFAH OSD GUI (35 B %1 o
e <Confirm New Password>
<Confirm New Password> 7Bt 455 <New Password> JUJC i 4 AT HE 4T 5 4.
*  <Reset>
H—ZFRT Portal %5, LG n[EIT <Reset> %4 )| R HHE N AT . BRI ARG HORIELS ) R . )RR skt
AT, SRS, R A .
IERAA A NACES J5, - Portal #ABR 4 BN A A58, I H AR GRS 0L i N B a1
TR RFACH, R Portal | RIS 215 E.

2-25: <Authorized Password Reset>

Authorized Password Resat

Contact your hardware vendor to reset a lost password,

Chalengs: XGJU - MGZD : S LV3G H2CTY = SNM.J

Response: || H H H H

[ ok Cancel |
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4-2 Natural Color

48 Natural Color?

F P AT PC & IBBXAE—A )8 AATTAE 53 LR B R (O 5 R 14T B0 R all ik 14 A sl A LA A\ TR s B €
¥ AN Natural Color J&—Fh O M 2248, 1 Samsung Electronics Wik, S0 Tl EiR A, %A 238 T = 20 5
BRSO R, R R AT R I R B S - R TN B RGBS AR
LAY (F1).

Natural Color 7E£ 420k, %] UM LLR Bk b R 430047 22 3%

http://www.samsung.com/us/consumer/learningresources/monitor/naturalcolorexpert/pop_download.html
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4-3 MagicTune
f+4 2 MagicTune?

MagicTune”

MagicTune J&—/N I B AL U0 s ds (B ERR e, et 1 S8 0 e s 4 T RE U W LUK A% 5 R (K R AR i v
BIor AR W K B R, R I bR B AR T Y SR s

GIERAF:

1. Bedeiidsi N CD-ROM Kshds .

2. kP MagicTune ZEFEF .

S AR R OR B R e T, S/ CD-ROM H4k #] MagicTune 11922k S0, IR 30T
3. R E I “Next” CF—24) 1.

4. FRARET ERE R e TR I 22 PR

o RRGEHREEATE RN, BRI IE R T AR,
o T EHLRGA RS A, TTREAS L MagicTune [&lFr.
o WEORMBURGETT KBRS, AT% FS .

4% MagicTune™ PR il 4440 ja) 8

MagicTune ™ 13255 iy A% 51 5 F . AR 4% R 30

oS

e Windows 2000

e Windows XP Home Edition
e Windows XP Professional

¢ Windows Vista

X+ MagicTune™, #:U{# ] Windows 2000 B 5 i R AS A1 2 4t

T
o A/ 32MB T
o Z/bAT 60MB (1) 1] FI %4 8]

W2, AR M.

T BB A
7F Windows F4i N, AT “Add or Remove Programs” (/s IHEUMIEAFERE) 1M MagicTune™
WM MagicTune™, %52 /8L~ 255K,

1. Wl “Start” OFUE) 1, #®FF[ “Settings” (KHE) ], RIGMSEHPEPE [ “Control Panel” (T o
I+ Windows XP, W[ “Start” (JFih) 1, SRJE MR HIESE] “Control Panel” (FEHIHHD 1.
2. Nk Y “Add or Remove Programs”  CGARINEMER AL EFr.
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3. fE[ “Add/Remove” CZIMNEE) 18 10, #k#FF1%+H MagicTune™.,
4. P[] “Change or Remove Programs” iR FEF) 1, MIBRIAE.
5. ¥l “Yes” (&) 1, JFUAMIER MagicTune™,

6. MEhI— W EHE, SR O kR .

CY 0% MagicTune ™ HISCHUH AR R . FAQ Ol LIRS ) SRERAFTI M5 K, i IIRATI I3

TR
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4-4  MultiScreen

H4 2 MultiScreen?

@ MultiScreen

HHE MultiScreen, 7 AR g o i i 1] 53 51 24 2/ R X .

RN
1. ¥z e sidi N CD-ROM BK5hgs .
2. ¥k MultiScreen Ze35F2% .

O o B R PR 2R, WR/E CD-ROM thk ] MultiScreen [ 256301, IR A
3. I MG, i [ “Next” (F—4) 1.
4. ARSI RN e e ORI L D IR
S o RS ANE AL, SRR R TCIR IR R LA
o T HSHURGAS A AR, ATREAR £ I MultiScreen b
o WIACRINIRIGET A EbR, n4% F5 B,

224 MultiScreen )RR #4440 ) /5

MultiScreen )23l fERZ S L AU R 2 RS (K 50 o

BIERSR

(O

e Windows 2000

*  Windows XP Home Edition
¢ Windows XP Professional

¢ Windows Vista

4 MultiScreen,  #14# H Windows 2000 B8 i RRAS (1 R 4

T
o Z/b 32MB N1
o F/bAF 60MB (1] H fifiFE 4% ]

IR B AF

$Tﬁ[ “Start” (JT4) B lﬂi.ikq)?[ “Settings” CHEED [ “Control Panel” CsHITRD . ;5(}\\;5;(1,45[ “Add o Remove
Programs” CZSINEHBRFET) 1o

TEFEFE S h ik 4% MultiScreen , KRG [ “Add/Delete” 7RIS 4%,
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5 HbEHEER

5-1 EsEiEH

o AT BZWT R RER B AT O T TARIE R .

o WRFENY PC IEMEERE S H I i H AR LED ANWTIARR, RS DU P BRIAT 2 WD fg .

RPA = Al PC R LY .

WA ity EHRN R 5 8k

FTOTAS il FL YL

UIRAT i TARIEHR, W L <BrdifE 52> 18

RAEOCT, W BL T A i, WO PC MBERRAT . A g TARIER .

P wnN e

bR
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5-2 HWRBERE
| TEZORE RIS ATEBEAT LU R A . WNZ S ARAEAE, IR B B ) R T RS hab.
H DU 6 T/ TEHEAT T A7 i B YR
P TR IR 2 oA LR AR Do
B BRI T <KdfE S ek> HE? Kt PC 5A i 2 [ SR 2 42

WIRAESE L COEMIEE IS DL R i BBl T X4 B )ﬂl 15
AP [ == /SOURCE %41, VAE Bk & A

B B A L T <A ARSI 6L

A2 S AR S S B AT i SRR R B OR 23 A e e R I 2
B A O -
FEXXFIIGLL T, 8 A7 i B B I 2 ) 70 R AR

AT B i HL AR LED B L R 1 B AN W7 A A 2

M TN RE IF AR IS AT IN 43 B B X R G
FL SRR B AT R B T P B S R

B ML RERRER A (0SD).

BRATHGY T B

Ky <OSD 8 E> IR &My “Ooff” (90 .

Bt EAAERE ) BREER

AP R s A B, BB PORACE b AE? | A LR SR .

FOHOR 2R e el AT AL

Ff <P EIRMCR> REHIREN <>,
B IEEE? 2% (T EER.

BIRXRRRB EIA LA ]

e 2R B R R ?

1% [AUTO] #4l, 1217 A shif &) fe

FETT S T IE AT i 1) 73 R AR AR 2

UK 2R 0 2 R R R W A
WS bRUEE AR

BARER ERRE?

Wz% (T REER.

KPS

SR T T AT B 4 AR 2

T SR R 2 AR AR 4 O 3 4
IHS bS5

R ERERKL 16 7 (16 1) .

EHERERFORRET ML,

ST LT AT i B IR B R ?

Windows ME/XP/2000: illidi%+ “Control Panel” (# il

) — “Display” (7r) — “Settings” (X'E) RKHEHk
B,
R AT 2 ARHEH A R IR SRy TR B B R
ERDRBEN, BaARIKMERE: WIEWHE “ (VESA DDC) B7R%#) 7.
ST LT AT i B IR B R ? AR B B T Py 2 BT S U ) 2 BB A IR B R o

ZZ BRI CHP TN, R LR SRR AT 1 R4 R
(VESA DDC) Jjfig.

AR DX )R P 2 R AH 50 1t ] 2 2he e 26 KB Y

JB BT ELALRT H BLREREL 75 &

U RAE A B TSI R [

FHBLT 3 k8 3 RUAE, TSRV RS .
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5E 5 K 1A

Jeti i S T 1 5 0 2 A R
St i 1.
BB

e Rt

LUE S Ea=s AT R E NPy N PN E ke a7 BRI Wk o= /O O
FEFF IR A o

bR
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BERU T !

oy B KRR 5 PR AR 2

RSB 2B SR R
(EZAFE, WESHWENEE RS P FID .

WM 5 o) R

Windows XP: iidi#$ “Control Panel” (¥ifit) —
“Appearance and Themes” (#MLAIES) — “Display”
(oR) — “Settings” (W'E) KREM AR

Windows ME/2000: Jliili##% “Control Panel” (F5HilTiiH)
— “Display” (l7R) — “Settings” (¥E) ok H o9
(L2ZEE, EZENERR T .

T AE A e ?

Windows XP: dlidikf¢ “Control Panel” i) —
“Appearance and Themes” (#MLFIE#) — “Display”
(f78) — “Screen Saver Setting” (JiHeAfdH i) #HATHC
B, DET AL BIOS BWE P TR E .

Windows ME/2000: JEilik#: “Control Panel” (FHilTHIHRD
— “Display” ({78) — “Screen Saver Setting” (5f %5:{#
PR BEATHCE, SAETHEHL BIOS BUE P HEATACE .

W2 EE, ESRFEN Windows R4 CH P FMD .
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6 HZER

6-1  Fitk
B 2 FR NC190 NC240
LCD &sht | KRzb 19 Je~f (48 JHK) 23.5 Hi-[(59 JEK)
BRI, 37.632JHK (KF) x30.11HK (& | 52.128JFHK (KF) x29.322JHK
H) (FEH)
B 0.2942£K (K P) x0.294z2Kk (| 0.27154K OKP) x0.27152K
H) (FEH)
[l 2 K- 30~81 kHz
B 56~75 Hz
WIREE, 16.7 M
Sy B HR 1280 x 1024 @ 60 Hz 1920 X 1080 @ 60 Hz (RB)
B PER 1280 x 1024 @ 75 Hz 1920 X 1080 @ 60 Hz (RB)
RGB 41
WA, s 0.7 VPP £ 5%
ISR D . A
TTL%4 (Vi =20V, VIL<08V)
IS INS SR TES 135 MHz 170 MHz (Bl #5
uR RS Ry 100 - 240 Vo 46 F 5 BHBIX [y bift b IR A7 A,
T 55 WA A T T AR 2
Ecxz4n 15 %I D-Sub & #:4%

JoF 8 X X))

41.07 x 34.44 X 740K (ANES4D

/3\
41.07 x 38.56 x 19.70 Jik (&4
16.2 T7%

56.86 X 7.77 x 34.19 JH K (A4 /
6.45 T30 (474 4%), 6.25 T30 (A7l

e

56.86 x 22.60 x 38.52 JH K (%47 /

8.85 -3¢ ({75 4%), 8.65 T-7u (Anifs

i as)

VESA $ERC 2 HAR 100 Zk x 100 2k 200 %K x 100 ==K / 100 x 100 ==K
(UEEZN s ZAT i 10°C ~ 40°C (50°F ~ 104°F)
WERE: 10 % ~ 80 %, Hoktss
e . -20°C ~ 45°C (-4°F ~ 113°F)
TS 5% ~95%, Johks;
fift 0" ~ 20

[@ B2k (/e ERsafi i s o)

Ao g EMUTEN (B2, @& TRERSIET . A7l /£ . (B R A IR B pim st~ T AR

-VXL%‘O )

EEZEDS)
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6-2 HFHINAE

AT PR I e, ATAETIE IN [0 B A G BRI 00 A oG bR, IR BERE. A" it A WIS, WY LED 2748
AT R, DR R AR T A A i b T RIS FRSF R SR AT, R 42 A T e ol B e R 57 e ik
o AL, A HIIRENAEA i B AT I e T SN LER S A A

W& IEHIBAT KA CRITIEHD
HLEHR AT PANC! ENl
NC190 :37 i 0 ki
IikE
NC240 /T 70 L M2 R

R BT HRIE DRI OG, A i A EWRTIT -EZ S D0~ A A i FEHLRE -
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6-3 ROHS

(FERPERERZR

R 00

. 10% 80%

ARG EPRYTE
* FpE E 4 bt 3

Hg) (PEB) (PBDE)
BN s k<A * O (o) O 0 (0]
A b O O O O )
SRS o o O o o o
ERmEr X O (o) O O )
HWERF * = L, 9] Q o

O: RFEELATVREEHEMAURMEP S BHES)/TI1363-2006 HFHAEMREERLT.
*: BEEAHATORELCETHMGME MR SMS TN/ TI1363-2006 FFERNTHRBESR

ARRTFERNBASHOEWYREE. SRIIARYAIHELAMES REMIGEOMMEES RAHRIENY.
H?ﬁ:ﬁgﬁﬁﬁ ENREEMEAKERS TERATREE. ZRETHTHBIFTLER
IEA .

DRRFERERAT
BRI 0740

CDT RSN 108808
HREEVEN TR

x W | At | smmx | SRo¥E
Hg) (Cré+) (pBB) | (PBOE)
ED Rl st £ X . o (o] o] o
BB X o) 0 (@] 0 o]
SRS MER o © Q o o o
R X o) 0 (o] 0 o
R % o O O o o

O: RTFRASHRYRE LGSR AHRHM DS 2SI/ T11363-2006 FEREMRBERLIT.
*: RTEHSAEVRELCELEANR—EME DS RHEHS)/T11363-2006 FRAEMEMMREER.

ARRTHNBAASHEOARYRTE SRMINFEVREHEHEES RENITEONAMEESRAHFREN.
HABREANARIREINEAKERHTETTHRES. ZERTHTHBTURK EFHIEEHE.

1&'"1;'1&1
- EUCHR A FEEEE I ET .
Bisiebhi§iE1T. 800-810-5858 17451 .
O HWMERIBE, hiREEERA.
2. XS BEWR hEREEREINE.
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6-4 EfZ SAMSUNG WORLDWIDE

B - Wi Samsung (197 B AT AETEE ) SR, 1515 SAMSUNG 9% 45 Hh bl 52 o

NORTH AMERICA

US.A 1-800-SAMSUNG(726-7864) http://www.samsung.com/us

CANADA 1-800-SAMSUNG(726-7864) http://www.samsung.com/ca

MEXICO 01-800-SAMSUNG(726-7864) http://www.samsung.com/mx

LATIN AMERICA

ARGENTINA 0800-333-3733 http://lwww.samsung.com/ar

BRAZIL 0800-124-421 http://www.samsung.com/br
4004-0000

CHILE 800-SAMSUNG(726-7864) http://www.samsung.com/cl

COLOMBIA 01-8000112112 http://www.samsung.com/co

COSTARICA 0-800-507-7267 http://www.samsung.com/latin

ECUADOR 1-800-10-7267 http://www.samsung.com/latin

EL SALVADOR

800-6225

http://www.samsung.com/latin

GUATEMALA 1-800-299-0013 http://www.samsung.com/latin
HONDURAS 800-7919267 http://www.samsung.com/latin
JAMAICA 1-800-234-7267 http://www.samsung.com/latin
NICARAGUA 00-1800-5077267 http://www.samsung.com/latin
PANAMA 800-7267 http://www.samsung.com/latin
PUERTO RICO 1-800-682-3180 http://www.samsung.com/latin

REP. DOMINICA

1-800-751-2676

http://www.samsung.com/latin

TRINIDAD & TOBAGO

1-800-SAMSUNG(726-7864)

http://www.samsung.com/latin

VENEZUELA 0-800-100-5303 http://www.samsung.com/latin
EUROPE

AUSTRIA 0810 - SAMSUNG(7267864,€ 0.07/min) | http://www.samsung.com/at

BELGIUM 02 201 2418 http://www.samsung.com/be (Dutch)

http://www.samsung.com/be_fr
(French)

CZECH REPUBLIC

800-SAMSUNG (800-726786)

http://www.samsung.com/cz

Distributor pro Ceskou republiku

samsung Zrt, teska organizani slodka, Oasis Flarenc, sokoloyska334A7, 180 00, Praha 8

DENMARK 8 - SAMSUNG (7267864) http://www.samsung.com/dk
EIRE 0818 717 100 http://www.samsung.com/ie
FINLAND 30 - 6227 515 http://www.samsung.com/fi
FRANCE 01 4863 0000 http://www.samsung.com/fr
GERMANY 01805 - SAMSUNG (7267864, € 0.14/ http://www.samsung.de
Min)
6-4 CIEA S,



EUROPE

HUNGARY 06-80-SAMSUNG(726-7864) http://www.samsung.com/hu

ITALIA 800-SAMSUNG(726-7864) http://lwww.samsung.com/it

LUXEMBURG 02 261 03 710 http://www.samsung.com/Iu

NETHERLANDS 0900 - SAMSUNG (0900-7267864) (€ http://www.samsung.com/nl
0,10/Min)

NORWAY 3 - SAMSUNG (7267864) http://www.samsung.com/no

POLAND 0801 1SAMSUNG (172678) http://www.samsung.com/pl
022 - 607 - 93- 33

PORTUGAL 808 20 - SAMSUNG (7267864) http://www.samsung.com/pt

SLOVAKIA 0800-SAMSUNG(726-7864) http://www.samsung.com/sk

SPAIN 902 - 1 - SAMSUNG (902 172 678) http://www.samsung.com/es

SWEDEN 0771 726 7864 (SAMSUNG) http://www.samsung.com/se

SWITZERLAND 0848-SAMSUNG (7267864, CHF 0.08/ http://www.samsung.com/ch
min)

U.K 0845 SAMSUNG (7267864) http://lwww.samsung.com/uk

CIS

BELARUS 810-800-500-55-500

ESTONIA 800-7267 http://www.samsung.com/ee

LATVIA 8000-7267 http://www.samsung.com/lv

LITHUANIA 8-800-77777 http://lwww.samsung.com/It

MOLDOVA 00-800-500-55-500

KAZAKHSTAN 8-10-800-500-55-500 http://www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

RUSSIA 8-800-555-55-55 http://www.samsung.ru

TADJIKISTAN 8-10-800-500-55-500

UKRAINE 8-800-502-0000 http://www.samsung.com/ua

http://www.samsung.com/ua_ru
UZBEKISTAN 8-10-800-500-55-500 http://www.samsung.com/kz_ru
ASIA PACIFIC

AUSTRALIA 1300 362 603 http://www.samsung.com/au

CHINA 400-810-5858 http://www.samsung.com/cn
010-6475 1880

HONG KONG 3698 - 4698 http://www.samsung.com/hk

http://www.samsung.com/hk_en/

INDIA 3030 8282 http://www.samsung.com/in
1-800-3000-8282
1800 110011

INDONESIA 0800-112-8888 http://www.samsung.com/id

JAPAN 0120-327-527 http://www.samsung.com/jp

EEZEDS)
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ASIA PACIFIC

MALAYSIA 1800-88-9999 http://www.samsung.com/my
NEW ZEALAND 0800 SAMSUNG (0800 726 786) http://www.samsung.com/nz
PHILIPPINES 1-800-10-SAMSUNG(726-7864) http://www.samsung.com/ph

1-800-3-SAMSUNG(726-7864)

1-800-8-SAMSUNG(726-7864)

02-5805777
SINGAPORE 1800-SAMSUNG(726-7864) http://lwww.samsung.com/sg
THAILAND 1800-29-3232, 02-689-3232 http://www.samsung.com/th
TAIWAN 0800-329-999 http://www.samsung.com/tw
VIETNAM 1 800 588 889 http://www.samsung.com/vn

MIDDLE EAST & AFRICA

SOUTH AFRICA

0860-SAMSUNG(726-7864)

http://www.samsung.com/za

TURKEY 444 77 11 http://www.samsung.com/tr
UAE 800-SAMSUNG(726-7864) http://www.samsung.com/ae
8000-4726
6-4 EZHER
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